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Message from the Executive Committee
Our communications matter. Whether you are communicating with the public, the Board of Directors, our 
stakeholders, other government departments or each other, you are representing our organization. 

We demonstrate our three core values of partnership, accountability and compassion in what we say and 
what we do. Our goal to be transparent and empathic is shown by our words and actions.

For these reasons, we are pleased to present a new edition of our Style Guide. This guide and the associated 
brand standards are essential in creating and maintaining our professional identity, speaking with one voice 
and communicating with sensitivity and clarity.

The Executive Committee strongly endorses the Style Guide and its use to maintain our brand guidelines and 
standards. 

Style Guide second edition
Style is alive! Language and writing style are in a constant state of change. Since the first edition of the 
Style Guide, new words have been added to our everyday language, like COVID-19. As well, how we refer 
to the territory has changed to “the” Yukon. Last but not least, we have a new name: Workers’ Safety and 
Compensation Board and the new Workers’ Safety and Compensation Act.
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Introduction
The Style Guide is here to help everyone:

• to follow our style—so that your writing demonstrates the professionalism of our organization;

• to write clearly and inclusively—so that you respectfully say what you need to say and your reader has 
a clear understanding.

Use this guide for all your internal and external communications. The guide is for all employees and for 
contractors writing material on our behalf. This guide follows the Government of Yukon (YG) Style Guide 
and writing standards, which is available at guide.yukon.ca/en/content-and-design/style-guide. The style 
standards here and in the YG guide are based on existing reference materials such as The Canadian Press 
Stylebook, Caps and Spelling and Writing Tips Plus, Government of Canada.

As an organization that is arm’s length from YG, we are in a position to set our own style. 

You can find our Style Guide and Brand Standards on our website at wcb.yk.ca/styleguide and via a link on 
SafetyNet.

We review and update this Style Guide regularly. When we do, we will notify employees of changes. Let us 
know your suggestions and feedback by email at  wcb-cs@wcb.yk.ca.

When you have a style question, follow the list below to find what you are looking for.

1. This Style Guide—follow what is in here first

2. The YG Style Guide

3. The Canadian Press Stylebook, and Caps and Spelling—every branch has a copy of each

4. Writing Tips Plus, Government of Canada

Please ask the Corporate Services Branch communications team—we welcome your questions!

When you have a question about spelling, refer to the Canadian Oxford Dictionary. It is available online and at 
the Corporate Services Branch.

A comment on grammar shaming: many of us had a difficult time learning grammar at school, if we were 
taught it at all. Consequently, some people learned more than others. No one needs to be anything close to 
an expert in grammar to work here or use this guide. 

We humbly offer this guide for support and guidance, and to stimulate discussion, never to cause shame, 
embarrassment or feelings of inadequacy.

https://guide.yukon.ca/en/content-and-design/style-guide
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/index-eng
https://www.wcb.yk.ca/web-0074/web-0081
mailto:wcb-cs%40wcb.yk.ca?subject=Style%20Guide%20Feedback
https://guide.yukon.ca/en/content-and-design/style-guide
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/index-eng
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Writing clearly and inclusively
Go to Writing in plain language and the YG Style guide.

Writing for your audience (reader)
We have an obligation to communicate clearly and effectively with the people we serve. This means always 
keeping the reader in mind. 

Before you begin writing, ask yourself:

• Who is reading my document? 

• What does the reader need and want to know?

• Is the reader already familiar with the issue I am dealing with? 

• What is the best way to present the information to make it easy to understand?

Writing in plain language
Plain language is writing your readers can understand the first time they read it. It avoids the use of complex 
terms, technical jargon and dense phrasing that makes it difficult to understand the message. We’ve all 
experienced inflated, bureaucratic language that we can’t understand.

As employees in a bureaucracy, we need to take care to avoid that kind of writing. The Yukon government 
Communications Policy states: 

“The use of clear, plain language is required in all government materials, including legislation and 
regulations, in order to support the greatest understanding of government programs, services, decisions 
and actions.”

Writing in plain, comprehensible language applies to all WSCB communications including correspondence, 
policies, forms and directives.

Writing can use plain language without losing its intent. Legal writing is among the most complex and poses a 
particular challenge for plain communication. but, as quoted above, we are expected to use plain language so 
that our readers—mainly employers and workers—can understand the laws that affect them. 

We can do this by making sure the language is clear, legal concepts are explained and technical terms are 
defined.

See the Resources section at the end of this guide, which has links to some plain writing resources.

Some plain language tips

• Use contractions like “we’re” and “you’re.”

• Avoid words ending in “–ion” and “–ment” as they tend to make sentences longer and more complicated 
than they need to be. 

The committee considered how to improve workflow, not The committee took into consideration potential 
improvements to workflow. 

• Use short sentences: aim for no more than 25 words.

• Use the active rather than passive voice. The active voice makes it clear who is responsible. In the active 
voice the subject performs the action expressed by the verb. 

Register for Optional Coverage online, not Registration can be made online.

• Address the reader as “you” where possible, for example, Send your form to us.

https://guide.yukon.ca/en/content-and-design/creating-content/guidelines-yukonca/writing-plain-language
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide
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• Use “we” as long as you’re making it clear as much as possible who the “we” is. Do not assume the 
audience will know. 

The Canadian Press Caps and Spelling has a list of plain words at the back. Here are some examples:

Long/formal/unfamiliar word

• advise

• cease

• complete

• demonstrate

• for the purpose of

• require

• utilize

Shorter/more familiar alternatives

• tell, write, inform

• stop, end

• fill out, finish

• show, prove

• to

• need, call for, ask for

• use

Every branch has a copy of The Canadian Press Caps and Spelling book.

Readability

A plain-language approach should result in high readability. Microsoft Word has a useful tool to test your 
document’s readability. 

To measure readability in a Word 2013 document:

1. In your open document, click on the File tab and select Options on the left. 

2. Select Proofing.

3. Under “When correcting spelling and grammar in Word,” check Show readability statistics.

4. Click OK. 

5. In your document, click on the Review tab and select Spelling & Grammar.

6. After the spelling and grammar check has finished, a pop-up window will appear. Under Readability 
 are three pieces of information:

 a. Percentage of passive sentences in your document
 b. Flesch Reading Ease score
 c. Flesch-Kincaid Grade Level

If you are writing for a general audience, aim for:
• a low percentage of passive sentences;

• a reading-ease score of 60 or higher; and

• a Grade 8 or 9 reading level. 

As well as referring to Writing in plain language, you can find helpful resources at the Plain English Campaign, 
which has downloadable free guides, for example:
• How to write in plain English

• The A to Z of financial terms

• The A to Z guide to legal phrases

https://support.office.com/en-us/article/test-your-document-s-readability-85b4969e-e80a-4777-8dd3-f7fc3c8b3fd2?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/test-your-document-s-readability-85b4969e-e80a-4777-8dd3-f7fc3c8b3fd2?ui=en-US&rs=en-US&ad=US
https://guide.yukon.ca/en/content-and-design/creating-content/guidelines-yukonca/writing-plain-language
http://www.plainenglish.co.uk/free-guides.html
http://www.plainenglish.co.uk/files/howto.pdf
http://www.plainenglish.co.uk/files/financialguide.pdf
http://www.plainenglish.co.uk/files/legalguide.pdf
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Readability example
Below is an example of a (made up) sentence using complex language and passive verbs, along with its 
readability scores. It’s followed by a plain language version and its scores.

Version with complex language:

Yukoners are required to submit their forms as soon as practicable 
for determination of eligibility and ongoing authorization for 
utilization of our currently available services.

• The Flesch Reading Ease test rates text on a 100-point scale. The 
higher the score, the easier it is to understand the document. 
This sentence scores zero, which is defined as, “Extremely 
difficult to read. Best understood by university graduates.” 

• The Flesch-Kincaid Grade Level test rates text on a U.S. school 
grade level. This sentence has a grade level of 20.5, which is 
obviously way higher than a high school education.

Version with plain language: 

Please send your form to us. We’ll review it and let you know which 
services you may use and for how long

• This sentence has the highest possible score for ease of reading 
and needs a Grade 1 or 2 reading level to understand it.

Writing inclusively
Go to YG Style Guide

According to the YG Communications Policy:
• “Language in public communications must be inclusive and respectful.” 

• Inclusive language is “respectful and is not biased based on race, gender, culture, class, ability, age, 
religious beliefs or sexual orientation.” 

Part of writing inclusively is making sure text is gender-neutral wherever possible. 
• they, their not, he/she, his or her

Increasingly, the use of “they/theirs” is not considered neutral. If you don’t know the preferred pronouns 
of the person you are addressing or referring to, try to rephrase the sentence to avoid personal pronouns 
altogether. Alternatively, use neutral terms such as “a person” or “a worker.”
• The worker will receive the following benefits, not She will receive the following benefits.

Other helpful resources:
• Government of Canada →  “Gender and sexual diversity glossary”
• Canadian Press Stylebook, 18th edition, pages 21 to 27. (Every branch has a copy)

Writing for social media
On social media, the audience is scrolling. In order to capture their attention in just a few seconds, plain, 
active language is a must. This kind of writing helps our audience understand our messaging quickly, easily, 
and completely.

It’s important to keep text limited to a few sentences, even less if possible. The goal is for our posts to grab 
our audience’s attention, then point them to our website or another source to get all the information.

https://guide.yukon.ca/en/content-and-design/style-guide/language/writing-inclusively
https://www.btb.termiumplus.gc.ca/publications/diversite-diversity-eng.html
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Writing for the web
We want our website to be accessible and easy to understand. Plain language, again, is incredibly important. 
Reading on a screen is different than reading on a page. To help our audience understand our information, 
breaking up the text with bold subheadings can be very useful. Anchor links—a link at the top of the page to a 
particular section within a page —are helpful for pages that have many paragraphs and different ideas. 

Web users spend, on average, less than one minute on a single webpage. Writing that is clear and concise will 
help better communicate our messages during this short time frame.

WSCB matters

Our name

Our organization’s full, formal name is the Workers’ Safety and Compensation Board. 

Use one or other of the following abbreviations for our full name: 

WSCB (omit “the,” for example, Send your form to WSCB); or

the board.

Be consistent—use one abbreviation or the other in a document or related documents.

Use “and” not an ampersand (&).

Workers’ Safety and Compensation Board, not Workers’ Safety & Compensation Board

It is fine to refer to our organization as “we,” “our” or “us” as long as it’s clear who you are referring to and the 
context doesn’t ask for formality.   

Call us at 867-667-5645. We welcome your questions.

Our office is open from 8 am to 5 pm, Monday to Friday.

We calculated your premiums.

Contact information
Workers’ Safety and Compensation Board

401 Strickland Street

Whitehorse, Yukon  Y1A 5N8

867-667-5645 or toll-free 800-661-0443

worksafe@wcb.yk.ca

wcb.yk.ca 

Job titles
Go to YG Style Guide on titles

All job titles are in lowercase, except deputy minister and “above,” which are capitalized. 

• safety officer, manager and claims assistant, not Safety Officer, Manager and Claims Assistant

• the Minister responsible for the Workers’ Safety and Compensation Board
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Be specific when referring to officers

WSCB has multiple officer roles, so always use the title to avoid confusion.

• Write safety officer or finance officer, not just officer.

When to capitalize job titles

In documents for internal government use and in your email signature box, you may prefer to capitalize all job 
titles. Use a consistent style within a document or related documents.

Board of Directors
Generally, we refer to the Board of Directors in full to avoid confusion with the “the board,” which is an 
abbreviation for our organization. 

Use “the board” as an abbreviation, but only in the context of writing that is specific to the Board of Directors.

Board members’ positions are capitalized:

• Chair, Alternate Chair

• Representative of Employers, Representative of Workers

Branches, units
Capitalize the names of branches and units at the board and use the correct, full names. 

• Claimant Services Branch

• Corporate Services Branch

• Employer and Client Services Branch

• Executive Branch

• Workplace Health and Safety Branch

• Operations Branch

• Finance Unit

• Information Management Unit

• Policy Unit 

Examples:

Every branch sent a representative to the meeting.

Employer and Client Services and Claimant Services branches sent representatives to the meeting, not 
Employer and Client Services and Claims sent representatives to the meeting.

The President/CEO represented the Executive Branch.

Programs
Capitalize the titles of specific programs, but not programs in general.

• Optional Coverage, COR Program

• health and safety programs, a return-to-work program
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Signature box
Your signature box should follow this format:

Name
Title
Pronouns
Branch | Program area or unit
Workers’ Safety and Compensation Board
m 867-667-0000 | f 867-335-0000 | e first.last@wcb.yk.ca | wcb.yk.ca

Email and any attachments sent by Workers’ Safety and Compensation Board staff are confidential 
and directed solely to the intended recipients. If you are not the intended recipient of an email 
you received from a staff member, please notify the sender immediately and delete the email and 
attachments from your system without making any copies in any format.

To create and format your signature box, follow the instructions in WSCB brand standard compliance in 
Microsoft Outlook.

We follow YG style for adding personal pronouns and an acknowledgment of traditional territories to your 
signature box.

Pronouns
Go to the YG Style Guide on writing inclusively By adding your pronouns to your signature, you:

• communicate you’re aware this is an important piece of information; and

• help create a work culture where it’s the norm to inquire about people’s pronouns so you do not 
accidentally use the wrong ones.

If you are adding a pronoun, do so directly below your name.

Traditional territories
See the YG Style Guide → Indigenous Peoples

You may want to acknowledge the traditional territories where we work in your email signature. If you choose 
to do this, some wording options include:

• I respectfully acknowledge that I work within the Traditional Territories of the Kwanlin Dün First Nation 
and the Ta’an Kwäch’än Council.

• I respectfully acknowledge that I work within the traditional territories of Indigenous Peoples. (If you work 
throughout the territory).

https://wcb.yk.ca/
http://safetnet/Libraries/Forms/Setting_up_your_email_signature.sflb.ashx
http://safetnet/Libraries/Forms/Setting_up_your_email_signature.sflb.ashx
https://guide.yukon.ca/en/content-and-design/style-guide/language/writing-inclusively
https://guide.yukon.ca/en/content/style-guide/government-references/aboriginal-peoples-and-indigenous-peoples
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The A to Z of WSCB style

Introduction
As much as possible, our style is consistent with the YG Style Guide. Follow the links.

Abbreviations
Go to YG Style Guide →  “Abbreviations and acronyms”

Abbreviations
In general, avoid abbreviations in writing, especially in formal documents. 

the government, not the gov’t

Avoid using the abbreviations “i.e.” and “e.g.” whenever possible because their meanings are often confused. 

• Instead of “i.e.” write “that is” or “in other words”

• Instead of “e.g.” write “for example” or “such as”

If you do need to use abbreviations, there’s no need for a comma afterwards. 

There are a range of work options, e.g. reduced hours and modified duties.

Employers must send their EPR by the deadline, i.e. by the last day of February.

See also Writing Tips Plus on abbreviations

Acronyms and initialisms
YG style recommends avoiding acronyms and initialisms altogether if you can. It can be hard work for readers 
to keep track of them.

Although formed the same way, acronyms and initialisms are pronounced differently. An acronym is 
pronounced as a word. 

NSNY, pronounced niz-nee (Northern Safety Network Yukon)

WHMIS, pronounced wim-iss (Workplace Hazardous Materials Information System)

In an initialism, each letter is pronounced separately.

WSCB

PDF

Don’t add an apostrophe to plural acronyms and initialisms. 

PDFs, Qs and As, not PDF’s, Q’s and A’s

If you need to use an initialism or acronym, write the name in full the first time, with the initialism or acronym 
in brackets. After that, you may use the initialism or acronym alone, but make sure you’re not causing your 
reader to keep checking what an acronym stands for. As well, remember that capital letters are harder to read.

Workplace Health and Safety (WHS), not (WH&S) or (WH and S)

post-traumatic stress disorder (PTSD)

Exceptions:

• CHOICES Program, which is always treated as an acronym and never spelled out. See the Spellings section.

• Acronyms and initialisms that have become part of the culture, for example, RCMP, CBC. 

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/abbreviations
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/abbreviations-acronyms-and-initialisms
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If you use several acronyms, consider including them in a glossary at the beginning of your document. Make it 
as easy as possible for your readers to understand what you have written.

See also Writing Tips Plus on acronyms and initialisms especially for details on when to use an article (the, a/
an) with and acronym or initialism, and which one to use (a or an).

Acts and regulations
Go to YG Style Guide on acts and regulations

We administer the Workers’ Compensation Act, the Occupational Health and Safety Act and the Workplace 
Health and Safety Regulations.

Once you have used the full name of an act or regulation, you can refer to it as “the Act” or “the Regulation” 
(not italicized, no quotation marks).

The Workplace Health and Safety Regulations are now available in a single publication. You can still request 
an individual part of the Regulations in small-booklet form.

The Government of Yukon is proposing to make changes to the regulations.

If you abbreviate the acts and regulations we administer, don’t use italics.

The WSC Act and the WHS Regulations, not the WSC Act and the WHS Regulations

The Workplace Health and Safety Regulations (WHS Regulations), not the Workplace Health and Safety 
(WHS) Regulations

If you refer to a part of the WHS Regulations, don’t put the title in italics and don’t add “Regulations.”

Part 2 - Confined Spaces, not Part 2 - Confined Spaces Regulations 

Please refer to Part 18 - Minimum First Aid Requirements of the WHS Regulations.

Refer to the YG list of Acts and regulations for correct names. Note that very few acts have “Yukon” in their 
names.  Add “Yukon” for clarity.

The Yukon Workers’ Safety and Compensation Act is very similar to Saskatchewan’s legislation.

Addresses
Go to YG Style Guide on contact information

See also Canada Post for various standardized address formats

And (ampersand)
Write the word “and” rather than an ampersand (&) except in very informal writing or when the ampersand is 
part of a name or title.

occupational health and safety, not occupational & safety

H&R Block, A&W

Appendices
Go to YG Style Guide on appendices

Capitalize the word “Appendix” when cross-referencing it.

See Appendix 1 for detailed financial data.

https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/abbreviations-acronyms-and-initialisms
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/legislation
http://www.gov.yk.ca/legislation/legislation/page_a.html
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/contact-information
https://www.canadapost-postescanada.ca/cpc/en/support/articles/addressing-guidelines/overview.page
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/appendices
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Capital letters (upper case)
Go to YG Style Guide on capitalization 

See also YG Style Guide on government references including Indigenous Peoples 

Use lower case whenever it’s possible and appropriate, because it’s easier to read. 

Units, branches, departments

Capitalize (use a capital for the first letter) for YG departments and branches, for example:

Mental Wellness and Substance Use Branch, Health and Social Services

Titles of office or rank

Capitalize the titles of office or rank.

Premier Jane Doe, Minister Jane Doe, Minister responsible for the Workers’ Safety and Compensation Board 
Jane Doe

The Premiers, Ministers and Chiefs will meet tomorrow with the Prime Minister

Titles of publications

Go to YG Style Guide on titles 

Capitalize the principal words (nouns and verbs) in titles of reports, guides, strategies, policies, forms and 
plans. Do not use italics or quotation marks.

Return-to-Work Guide for Employers

WSCB Safety Plan

Payment of Assessments policy

Capitalize the principal words in titles of books and put them in italics.

• The Canadian Press Caps and Spellings is a handy reference for Canadian spellings

Dates
Go to YG Style Guide on date and time

Word form

Use the day-month-date-year format.

Friday, October 1, 2021

Put a comma after the year in a sentence. Omit the comma when you write only the month and year.

The last Christmas party was held on Saturday, December 1, 2020, on Zoom! 

A news release in June 2021 announced the winners of the Safety Culture Contest.

Do not use the ordinal suffixes: st, nd, rd, th except where the date comes before the month or stands alone.

February 14, not February 14th or February 14th 

She is acting from the 3rd to the 15th of March.

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/capitalization
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/government-references
https://guide.yukon.ca/en/content/style-guide/government-references/aboriginal-peoples-and-indigenous-peoples
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/titles
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/date-and-time
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Microsoft Word changes ordinal suffixes into superscripts (1st, 22nd, 43rd, 60th) by default.

To avoid this: 

1. In your open document, click on the File tab and select Options on the left. 

2. Select Proofing. 

3. Click the AutoCorrect Options button and select the AutoFormat As You Type tab.

For date ranges, use the word “to” between the two dates.

December 4 to 6

In a table or chart, use an en dash (not a hyphen), with no spaces on either side.

Dec. 4–6 

Numeric form 

Use the international style (yyyy-mm-dd). Use hyphens, not slashes.

2022-01-14, not 2022/01/14

For date ranges, separate overlapping years with en dashes, not slashes.

2019–2020 or 2019–20, not 2019/2020 or 2019/20

Go to the Punctuation section for information about hyphens, en dashes and em dashes.

Digital style
Go to YG Style Guide on internet and digital terms

Go to Guidelines on Yukon.ca on links

Digital terms

For the spelling of common digital terms such as web page, website, see the Spellings section

Camel case

Camel case is where capital letters are embedded in compound words. If in doubt, look up the spelling.

eBay, FedEx, iPhone, PowerBook, WorkSafeBC

Using links

If a sentence ends with an email address or website URL, put a period at the end and make sure it’s not part 
of the hyperlink.

My email address is firstname.lastname@wcb.yk.ca.

For further information visit wcb.yk.ca/rates.

Do not include the prefixes http:// or www.

awcbc.org, not https://awcbc.org.

Make sure hyperlinks are not active in documents intended to be printed.

First Nations
See Indigenous Peoples

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/internet-and-digital-terms
https://guide.yukon.ca/en/content-and-design/creating-content/guidelines-yukonca/url-standards-yukonca
http://wcb.yk.ca/rates
http://www/
http://www/
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Government of Canada
Go to YG Style Guide on Government of Canada

the Government of Canada, not the government of Canada

the federal government, not the Federal Government

Government of Yukon
Go to YG Style Guide on government references

Formal name: the Government of Yukon, not the government of Yukon

the territorial government, not Yukon Territorial Government

the governments of Canada and Yukon, not the Government of Canada and the Government of Yukon

Yukon government can be abbreviated to “YG,” but the government prefers “to limit “YG” to internal use. 
Don’t forget to use “the” government.

The Government of Yukon announced changes to the WHS Regulations, not Yukon government 
announced...

The President met with colleagues from YG, not…colleagues from the YG.

Headings
Go to YG Style Guide on headings 

Use sentence case (capital letter on only the first word), unless one of the words is a proper noun.

How to conduct a risk assessment, not How to Conduct a Risk Assessment

Optional Coverage benefits, not optional coverage benefits or Optional Coverage Benefits

Indigenous Peoples
Go to YG Style Guide on Indigenous Peoples

There is a lot of helpful information and guidance in the YG Style Guide.

Yukon First Nations governments 

• Carcross/Tagish First Nation

• Champagne and Aishihik First Nations

• Kluane First Nation

• Kwanlin Dün First Nation 

• Liard First Nation 

• Little Salmon/Carmacks First Nation 

• First Nation of Na-Cho Nyäk Dun 

• Ross River Dena Council 

• Selkirk First Nation 

• Ta’an Kwäch’än Council 

• Teslin Tlingit Council 

• Tr’ondëk Hwëch’in 

• Vuntut Gwitchin First Nation 

• White River First Nation 

To insert an umlaut, either go to the Insert tab and Symbols, or use the keyboard shortcut (press and release 
Ctrl + Shift + semicolon (in other words, Ctrl + colon), and then press the vowel). See the Symbols section in 
this guide.

https://guide.yukon.ca/en/content/style-guide/government-references/government-canada
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/government-references
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/headings
https://guide.yukon.ca/en/content/style-guide/government-references/aboriginal-peoples-and-indigenous-peoples
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Job titles
See Capitalization section

Go to YG Style Guide on titles

See also Writing Tips Plus on capitalization: titles of office or rank

Generally, use lower-case for job titles. This includes titles such as analyst, manager and director. Use capital 
letters for all executive level jobs, which includes the President/CEO, Chief Financial Officer, Board Manager 
and Board of Directors.

Lists (vertical)
Go to YG Style Guide on bullet point lists

YG style follows guidance from the Plain English Campaign on how to punctuate lists.

There are two main types of lists. Punctuate your list based on the type of list it is.

List items are complete sentences

Begin each item with a capital letter and finish it with a period.

Our five strategic goals are as follows:

1. All Yukoners participate in a culture of safety and prevention of physical and psychological injury.

2. Injured workers recover successfully and sustainably.

3. WSCB stakeholder relationships are positive and strong.

4. Yukon employers and workers know and understand their rights and responsibilities under the 
legislation we administer, and they work with WSCB to fulfill those rights and responsibilities.

5. WSCB consistently demonstrates corporate excellence and is a leader in complying with the acts, 
regulations, policies and directives that govern its operations.

Use numbers, rather than bullets, when the order of the list items matters.

List items are words or phrases (not full sentences or complete the introductory words)

If you use the kitchen, the fees are:

• coffee or tea: $125 per year or $15 per month;

• tea only: $50 per year;

• neither coffee nor tea: $10 per year; or

• occasional single cup of coffee or tea: $1.

Parallel structure
Create a parallel structure so that each item or idea in your list matches. In other words, it should follow the 
same grammatical pattern. By creating word patterns your list is easier to read.

You can use the dictionary to find these: 

word meanings; 

pronunciations; 

correct spellings; and 

irregular verbs. 

Not You can use the dictionary to find these: 

word meanings; 

to check pronunciations; 

find correct spellings; and 

looking up irregular verbs.

See also Writing Tips Plus on vertical lists

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/titles
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/capitalization-titles-of-office-or-rank
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/bullet-point-lists
https://www.plainenglish.co.uk/punctuating-bulleted-lists
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/vertical-lists
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Ministers
Go to YG Style Guide on titles

Numbers
Write numbers one to nine in letters and numbers 10 and above in figures.

If your sentence has a combination of related numbers below and above 10, use figures for all of them.

Where a sentence starts with a number, spell it out (or rework the sentence so it doesn’t begin with a 
number).

Two thousand students participated in our outreach programs.

or

We reached 2,000 students with our outreach programs.

not

2,000 students participated in our outreach programs.

Punctuation
See Writing Tips Plus and search for your punctuation question

Apostrophe

Apostrophes are used for possessive nouns and contractions.

We will use the boardroom for Tuesday’s meeting.

they’ve (they have), it’s (it is)

While we try to avoid contractions (such as I’d, won’t) in the most formal documents, they add conversational 
warmth to writing. As well, plain language experts recommend using them for better readability.

Apostrophes are not used in the following.

1950s, ’50s, not 1950’s, ’50’s

WSCB distributed a percentage of its surplus, not WSCB distributed a percentage of it’s surplus.

Dos and don’ts, not do’s and don’t’s

Colon

A colon signals that what comes next is directly related to the previous sentence. 

The WSCB building has several entrances: one entrance is for the public and the others are for staff. (In this 
example, a semicolon could be used instead.)

The WSCB building has the following kitchen areas:

• Training Room 

• West wing near the Executive offices

• West wing near the OHS offices

• East wing on the second floor

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/titles
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/index-eng
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A colon is used in a formal letter after the salutation. If you use a colon after the salutation, for consistency, 
use a comma after the closing.

Dear Ms Jones: … Sincerely, 

or

Dear Ms Jones … Sincerely

not 

Dear Ms Jones: … Sincerely

Comma

Go to YG Style Guide on commas

Like YG, we don’t use the serial (Oxford) comma, so when listing items in a series, do not put a comma before 
the “and” or “or.”

Send your form by mail, fax or in person, not Send your form by mail, fax, or in person.

Sometimes it makes sense to add the comma for clarity.

The departments of Economic Development, Health and Social Services, and Community Services took part.

Dashes 

Go to YG Style Guide on hyphens and dashes

Em dash (long dash)

An em dash is the width of a capital M. It can be used as a substitute for a colon, semicolon or for commas to 
set off an area of text (parenthetical text) and to create a more emphatic or abrupt break in the sentence. 

The job needs to be done—and it needs to be done today!

The job—filing the documents—needs to be done today.

To insert an em dash in a Word document type two hyphens (--) between two words without spaces. The 
computer will autocorrect the hyphens to form an em dash. 

En dash (short dash)

We mainly use an en dash to connect numbers in a range—such as dates, times and page numbers—but only 
in a table or chart. Use “to” rather than a dash in sentences.

May 6 to 10, not May 6–10.

$2,500 to $3,000, not $2,500–$3,000.

To insert an en dash in a Word document hold down the control key and type a hyphen on the number 
keypad. Alternatively, go to the Insert tab and select Symbols, then More Symbols… and select the 
Special Characters tab. You’ll see en and em dashes listed.

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/commas
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/hyphens-and-dashes
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Hyphens

Go to YG Style Guide on hyphens and dashes

A hyphen has a variety of uses. Two common ones are:

To separate numbers that are not inclusive such as phone numbers and dates in numeric form.

• 867- 667-5645

• 2021-11-22

To join two or more words, such as compound adjectives.

• An up-to-date report, but the report was up to date

• A return-to-work plan, but a plan to return to work

Period

Go to YG Style Guide on periods

Nowadays, the convention is to put only one space after a period at the end of a sentence. Using two spaces 
dates from manual typewriter days, when every letter took up the same horizontal space. 

If a sentence ends with an email address or website URL, put a period at the end and make sure it’s not part 
of the hyperlink.

Quotation mark

Use double quotation marks. Place periods and commas inside the closing quotation mark.

What he actually said was, “We will announce the new rates in September.” 

Place semicolons and colons outside the closing quotation mark.

Last Tuesday you said, “Your cheque has been mailed”; I have yet to receive it.

See also Writing Tips Plus on quotations: punctuation with quotation marks

Use single quotation marks for a quotation within a quotation.

In the WHS Regulations, “IDLH means ‘Immediately Dangerous to Life or Health’.”

Semicolon

A semicolon links two full sentences (independent clauses) that are closely related and aren’t separated by 
one of the following seven words—for, and, nor, but, or, yet, so (coordinating conjunctions). The two could be 
sentences on their own if you put a period between them instead.

I’ll be making an important presentation to the Board of Directors tomorrow; I need a good night’s sleep.

I’ll be making an important presentation to the Board of Directors tomorrow, so I need a good night’s sleep.

Semicolons can also be used to separate items in a complex list.

The team includes Sally from the Finance Unit, Operations Branch; Jack from CST, Employer and Client 
Services Branch; and Morgan from the Policy Unit, Corporate Services Branch.

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/hyphens-and-dashes
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/periods
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/quotations-punctuation-with-quotation-marks
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Symbols
Per cent (%)

Only use the per cent sign. Leave no space between the figure and the sign. 

It was an increase of 9%, not It was an increase of nine per cent.

Write “per cent” in full if the number is spelled out because the sentence begins with a number. 

Fifty per cent of staff were working from home, not 50% of staff were working from home, nor Fifty % of 
staff were working from home.

Diacritics (accents, umlauts)

Some letters in French words have accents and some First Nations’ names contain umlauts. To insert:

• go to Insert then Symbol; or 

• press and release Ctrl + Shift + semicolon (in other words, Ctrl + colon), and then press the vowel.

Measurements

Use the degree symbol as follows:

Temperatures dropped to -32 °C, not Temperatures dropped to -32°C.

• There is a space between the number and the Celsius symbol.

To insert the degree symbol:

• Go to Insert then Symbol and More Symbols…

• Select Latin-1 Supplement from the Subset drop-down menu.

• Once you’ve used the degree symbol, it automatically appears in the Recently Used Symbols list in the 
Symbol Menu.

Telephone numbers
Go to YG Style Guide on contact information 

Use hyphens, not brackets and hyphenate toll-free.

Phone: 867-667-5645 or toll-free in Yukon 1-800-661-0443

Time
Go to YG Style Guide on date and time

In most written material we use the 12-hour clock when referring to time.

• Use am and pm, not AM and PM. There’s no need to add periods.

• Use 3 pm not 3:00 pm, but use 3:00 pm to 3:30 pm, not 3 pm to 3:30 pm.

• Use 12:00 noon and 12:00 midnight, not 12:00 pm and 12:00 am, as these are ambiguous.

Time zones

The Yukon observes Pacific Daylight Saving Time year-round. It’s called Yukon Standard Time.

Yukon Standard Time, UTC-7, not Yukon Time, Yukon time

For abbreviating other time zones, we follow Writing Tips Plus

4:30 pm EST

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/contact-information
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/date-and-time
https://yukon.ca/en/seasonal-time-change
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/abbreviations-time-zones
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Titles
Go to YG Style Guide on titles

For reports and other publications, capitalize the main words (title case). Do not use italics or quotation marks. 
Use italics for book titles.

Find the Workplace Violence and Harassment Prevention Guide on our website.

Refer to The Canadian Press Caps and Spelling for an A to Z of Canadian words.

Yukon
Go to YG Style Guide on Yukon and the Yukon

When referring to the territory, use “the” Yukon.

Get information about COVID-19 in the Yukon, not Get information about COVID-19 in Yukon.

Yukon government
Go to YG Style Guide on Government of Yukon 

Go to Government of Yukon in this document

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/titles
https://guide.yukon.ca/en/content-and-design/style-guide/government-references/yukon-and-yukon
https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/government-references/government-yukon
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Spellings
Go to YG Style Guide on spelling

See also Writing Tips Plus and search for your commonly misused word.

See also The Canadian Press Caps and Spelling book (there’s a copy in your branch)

Use Canadian spellings, for example: 

colour, neighbour, counsellor, traveller, not color, neighbor, counselor, traveler, 

These tools can help you with spelling and following Canadian spelling:

• The Canadian Press Stylebook and The Canadian Press Caps and Spelling.

• The Canadian Oxford Dictionary always gives the Canadian spelling first, with the US spelling in 
parentheses. For example, “per cent (also percent).”

• Microsoft Word’s spellchecker flags common spelling mistakes (you’re vs. your; its vs. it’s; they’re, their, 
there), but it is not foolproof. Make sure your version of Word is set to Canadian English.

• Go to YG Style Guide on spelling for helpful lists including the following:

Words we commonly use, such as:

• health care (noun) health-care (adjective), not healthcare

• north (direction), North (region), northerner, not Northerner

Associations and non-government organizations, such as:

• Les EssentiElles

• Learning Disabilities Association of Yukon (LDAY)

Businesses, such as:

• ATCO Electric Yukon

• Integra Tire (formerly Yukon Tire)

Facilities and buildings, such as:

• École Émilie-Tremblay

• Yukon Beringia Interpretive Centre

Municipalities, such as:

• City of Dawson, not Dawson City

Place names, such as:

• Arctic Circle, the Arctic, but arctic wildflowers

• Whistle Bend subdivision

https://guide.yukon.ca/en/content-and-design/government-yukon-style-guide/z-style/spelling
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/index-eng
https://guide.yukon.ca/en/spelling
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Some WSCB spelling preferences
advisor, not adviser

CHOICES Incentive Program

Compensation Fund (capitalized), abbreviated to “the Fund”

coordinate, not co-ordinate

cooperate, not co-operate

counsellor (a person who gives guidance) 

COVID-19, not Covid-19 or Covid

co-worker, not coworker

cyberbullying, not cyber-bullying

cyberspace

decision making, decision makers, decision-making process, a decision-making body

e-commerce

email

Employer Advisor, Employer Advisor Service (at the Yukon Chamber of Commerce) 

e-waste

Facebook

Grade, for school grades, Grades 1 to 12

hashtag

health care, not healthcare

home page

Instagram

internet, intranet

joint health and safety committee (but Joint Health and Safety Committee when referring to the specific JHSC 
at WSCB)

licence (noun), a driver’s licence

license (verb), licensed for Class 1 vehicles 

livestream

loss of earnings, loss of earnings benefit

musculoskeletal

per cent

practice (noun), doctor’s practice 

practise (verb), licensed to practise 

return to work, return-to-work program

SafetyNet
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selfie

SharePoint

St. John Ambulance, not St. John’s Ambulance

Twitter, tweet

web, web browser, webcam, webcast, web-enabled, web page, web server, website 

well-being

well-meaning, well-liked

Workers’ Advocate Office

Workers’ Safety and Compensation Act

Workplace Health and Safety Regulations 

workplace, not work place

worksite, not work site 

WorkSafeBC

Yukon.ca (capitalize Y)

Zoom
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Abbreviations, initialisms and acronyms

AAP alternative assessment procedure
AWCBC Association of Workers’ Compensation Boards of Canada
AYC Association of Yukon Communities
CAALL Canadian Association of Administrators of Labour Legislation
CAALL-OHS Canadian Association of Administrators of Labour Legislation–Occupational Safety and Health
CCL Cabinet Committee on Legislation
CHOICES Choose Healthy workplaces, Ownership of prevention and return to work, Injury 

management, Consensus-based programs, Employers of choice and Safety as job 1.
CICA Canadian Institute of Chartered Accountants
CMA Canadian Medical Association
COR Certificate of Recognition
COREL Certificate of Recognition equivalency letter
CSA Canadian Standards Association
CYFN Council of Yukon First Nations
DMRC Deputy Minister Review Committee
EMO Emergency Measures Organization
EPR Employer’s Payroll Return and Contract Labour Report
ERM enterprise risk management
FAF functional abilities form
FIAC Finance, Investment and Audit Committee
IAIABC International Association of Industrial Accidents Boards and Commissions
IAQ indoor air quality
IFRS International Financial Reporting Standards
IJA interjurisdictional agreement
IME independent medical examination
KPMA Klondike Placer Miners’ Association
NAOSH North American Occupational Safety and Health
NIDMAR National Institute of Disability Management and Research
NSNY Northern Safety Network Yukon
NWISP National Work Injuries Statistics Program
OAG Office of the Auditor General of Canada
OCOP Owner/Operator Certificate of Proficiency
WH Regs Workplace Health Regulations
WHS Workplace health and safety
OPCOR Optional Coverage Certificate of Recognition
PIDWA Public Interest Disclosure of Wrongdoing Act
PPE personal protective equipment
PPD permanent partial disability
PPI permanent partial impairment
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PRC Policy Review Committee (YG)
PWG Policy Working Group
Prev Gr Prevention and Safety Advisory Group
PSAC Public Service Alliance of Canada
PTSD post-traumatic stress disorder
RSI repetitive strain injury
RTW return to work
SAC Stakeholder Advisory Committee
SECOR Small Employer Certificate of Recognition
TIAY Tourism Industry Association of the Yukon
TLC Temporary Letter of Certification
TTD temporary total disability
WAO Workers’ Advocate Office
WHMIS Workplace Hazardous Materials Information System
YCA Yukon Contractors Association
YCC Yukon Chamber of Commerce
YEU Yukon Employees’ Union
YFL Yukon Federation of Labour
YG Government of Yukon
YMTA Yukon Mine Training Association
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Resources
Canada Post 

Canadian Oxford Dictionary (Corporate Services Branch has copies)

The Canadian Press Caps and Spelling, 21st edition

The Canadian Press Stylebook, 18th edition

Clarity International promotes plain legal language and design

Government of Yukon Style Guide 

Hemingway Editor app 

NWT Literacy Council/GNWT Write for Your Reader: A Plain Language Handbook includes examples of 
complex writing made plain

plainlanguage.gov is the United States government’s guide to using plain language. It includes:

• A plain language checklist

• Evidence plain language saves time and money

Writing Tips Plus Government of Canada style

https://www.canadapost.ca/tools/pg/manual/pgaddress-e.asp
https://www.clarity-international.org/
https://guide.yukon.ca/en/content-and-design/style-guide
https://hemingwayapp.com/
http://en.copian.ca/library/learning/nwt/writread/writefor.pdf
https://www.plainlanguage.gov/guidelines/
https://www.plainlanguage.gov/resources/checklists/checklist/
https://www.plainlanguage.gov/resources/articles/the-bottom-line/
https://www.noslangues-ourlanguages.gc.ca/en/writing-tips-plus/index-eng
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